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Santa’s Little Credit Helper v.1.0 
 
 Welcome to Santa’s Little Credit Helper v.1.0!  Santa’s Little Credit Helper 
(SLCH) is a powerful ScriptUI Panel for After Effects to create credits for broadcast 
television, feature, or web video. With this powerful tool, you have the ability to easily 
import credits from the supplied Google Sheet Template, customize the look, and render 
finished credits for you favorite editing application. And you can do it all quickly, easily, 
and accurately.  
 
I. Installation 
 

1. Be sure the Script file, SantasLittleCreditHelper_1.0.jsxbin, is in the ScriptUI 
Panels folder, inside the Scripts folder of your After Effects Application. 

2. IMPORTANT NOTE: For many features of this script to work properly, you 
MUST go into your Preferences/General tab and be sure “Allow Scripts to 
Write Files and Access Network” is checked.  

 
 Once installed, launch After Effects as normal. At the bottom of the 
Window Menu, select “SantasLittleCreditHelper_1.0” This should launch a new 
panel window with Santa’s Little Credit Helper. If you prefer, you may dock this 
panel into any available space in your After Effects interface. 

 
II.  Santa’s Little Credit Helper ScriptUI Panel Interface 
 

 The main interface panel for SLCH is compact and conveniently 
organized to help you work quickly and efficiently. 

 
  
 
 
 
 
 
 
 
 
 
 
 

a. Tab Bar: Along the top of the panel is a row of Tabs: Format, Presets, 
Load Credits, New Credits, and Help. 

b. Progress Bar: This bar will display the progress of certain task when 
the Script is running. 

c. Tools: This collection of buttons includes several tools you will use to 
work with your Credit Compositions. 

  

Figure 1. The SLCH Script UI Interface 

A.	Tab	Bar	

B.	Progress	Bar	

C.	Tools	
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III.  Tabs  
 

1.  Format Tab 
 
 

 
 

In this tab you set the format and timing of your credits. In the 
Dimensions dropdown list, you may select from 4 broadcast standards: 
720 (720x1080), 1080 (1920x1080), UHD (3840x2160), and 4K (4096x2160). In the 
Duration text field, enter the duration of your credits in seconds. (This 
field will be overridden by the value in your .txt file if importing credits.) 
The next dropdown list will set your timeline framerate (24, 25, or 30fps). 
At the bottom of the tab, select the checkbox to re-apply these values to an 
existing Credit Composition when you retime the Comp. (Otherwise, the 
Credit Composition will re-calculate the cards lengths, but not change the 
duration or framerate.)  
 
 

2. Presets Tab 
 
 
 

 
In this tab you can save and load presets for credit styles you’d like 

to save. To Save a Preset, select the Credit Comp you’d like to save. Press 
[Save Preset], and a prompt will ask you for a name. To Load a Preset, 
select the name of the preset you’d like to load from the dropdown list. 
Then, be sure to select a Credit Composition you’d like to load the preset 
into, then press [Load Preset]. 

 When you Save a Preset, all of the settings on the CONTROLS 
null will be saved, along with it’s position & scale. Likewise, all of the 
Fonts, Fill Color, Stroke, Stroke Color, and Justification settings for both 
your Title & Name Layers.  

 If you have more than one CONTROLS null in your Credit 
Composition, all of them will be saved. When the Preset is loaded, if there 
is any mismatch in the number of CONTROLS in the new Composition, 
nulls will be created/deleted to correct. If nulls are created, they will be at 
the bottom of your layer stack in the timeline. 

 If there is a mismatch in the format (720, 1080, UHD, or 4K) of 
the Preset and the Credit Composition being loaded into, you will be 
prompted how to handle this: either Resize your Composition, or adjust 
the values of the preset to make the style match the different frame size. 

If fonts used in a Preset are not installed, an alert will let you know 
what fonts are missing. 
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3. Load Credits 

 
 
 
 

In this tab you can select and import a credit file from a tab delimited 
text file. (See Section VII for explanation of the Excel/Google sheet 
template.)  To begin, press [Browse] to open a file selection dialogue. 
Navigate to you credits text file and select it. The pathname of the file will 
appear in the text field and the [Load] button will become active. Press 
[Create] to create a Credit Composition from your file. 

The default composition name will be the Show Name and Episode 
Number from your file separated with an underscore. (i.e. Detroiters_201, 
WhaleWars_412, etc.)  If a Composition already exists with that name, 
you will be asked to overwrite the existing credits. If you press [OK], the 
existing composition will be deleted. If you press [cancel], “_2” will be 
added to the default composition name. 

 Once the credits finish creating, the Composition will 
automatically be loaded into you Viewer & Timeline. 

 
 

4. New Credits 
 
 
 
 

If you do not have credits pre-typed into one of the provided 
templates, you may still use the other features of SLCH. To begin, 
determine how many Cards and how many Columns per card you will 
need. (For columns, it’s easiest to enter the largest number of columns 
needed on any card. Then, you will either leave blank or delete the unused 
columns in other cards.)  

Once you know what you need to create, enter the name of the 
Credit Composition you would like to create in the left side text field. 
Enter the number of cards and columns accordingly. When ready, press 
[Create] and a Credit Composition will be created and automatically 
loaded into the timeline and viewer windows. 

 
5. Help 

 
 
 
 

Here you will find a link to a shared Google Docs folder that 
contains 4 pre-made template files. For ease, there is ones for each of 1-4 
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columns. A copy can be saved to your own Google Docs drive for easy 
collaboration, or it may be downloaded as an Excel spreadsheet to be used 
offline. 

 
 

IV. The Credits Composition 
 

Once you used the Script UI panel to create a Credit Composition, you 
will find it inside the “1_Santa’s Little Credit Helper” folder in your project with 
a name based on the information found in the .txt used to create it (title & 
episode). A subfolder will be created that contains the Credit Composition and a 
“Cards” folder containing the individual pre-comps of each card created. 
IMPORTANT: You may rename and move the folder that contains the Credit 
Composition and cards, however you MUST NOT rename or duplicate the Credit 
Composition itself without using the [Rename Comp] & [Copy Comp] tools. The 
expressions used by the CONTROLS null are based on this name. 

At the top of the Credits Composition, you will find a null named 
CONTROLS. This null will be the control center of the Credit Composition 
where you can adjust size, placement, spacing, and other settings that effect the 
look of your credits. This CONTROLS null may be duplicated as needed to create 
different settings for later sections of your credits. To do so, place the 
CONTROLS null above the first card of the new section of credits. All Cards will 
take their settings from the first CONTROLS null they encounter above them in 
the timeline. (Please note: The first CONTROLS null must not be renamed. All 
additional CONTROLS nulls may have additional descriptive text added to the 
name, but the name must begin with “CONTROLS.”)  
 Below the CONTROLS null are all of the Card layers created for the 
Credit Composition. They will always be sequenced from top to bottom for the 
length of the Comp. Each Card layer will begin with 5 Effect controls. They are: 
 

a. Fixed Duration (in sec): The fixed length of this card when the Credit 
Composition is re-timed. This overrides any Weighted Duration timing 
value. If you want to use a weighted time instead, leave this set to 0. 

b. Weighted Duration (in sec): The weighted duration of this card when 
the Credit Composition is re-timed. If set to 1, the card will be of equal 
length as all other weighted cards. If set to 2, the card will be twice the 
length of the other weighted cards, and so on. 

c. IgnoreFadeIn: If checked, the layer will always cut on, ignoring the 
Fade In/Out setting on the CONTROLS Null. 

d. IgnoreFadeOut: If checked, the layer will always cut off, ignoring the 
Fade In/Out setting on the CONTROLS Null. 

e. Drop Shadow: A standard After Effects Drop Shadow effect. All 
values are linked to the Drop Shadow Effect on the CONTROLS null, 
so cannot be changed individually. 
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V. CONTROLS Null 
 

The CONTROLS null is the nerve center of any Credits Composition. 
Positioning, column widths, style, centering, and more are set from this single 
layer in order to keep a uniform look for each card. Below is a list of the settings 
on the null and what they do. For a visual reference of how each one effects the 
look of your credits, see the Appendix. 

   
a. Title Scale: Adjusts the appearance of the font size of title layers. 
b. Title Spacing: Adjusts the line spacing of title layers. 
c. Title Tracking: Adjusts the tracking of title layers. 
d. Name Scale: Adjusts the appearance of the font size of name 

layers. 
e. Name Spacing: Adjusts the line spacing of name layers. 
f. Name Tracking: Adjusts the tracking of name layers. 
g. Title-Name Separation: Adjusts the spacing between the bottom of 

each title & then first name line below it. When Side x Side is 
checked, this value will adjust the horizontal spacing between the 
title and name layers. 

h. Block Spacing: Adjusts the spacing between the last name line and 
first title line that appear in the same column. When Side x Side is 
checked, this adjusts the vertical spacing between blocks of names 
in each title. 

i. Side x Side: When unchecked, Title layers will be positioned above 
names in each Column on each Card. When checked, Title layers 
will be positioned to the left side of the first name in subsequent 
name layer. NOTE: when checked, Columns will be ignored and all 
credits will appear in a single column. 

j. Bottom Justify: When unchecked, all Columns will be positioned 
with their top lines aligned with the CONTROLS null and 
continuing downward. When checked, the last line of all Columns 
will be aligned with the CONTROLS null. 

k. Bottom Line Floor: When checked, (and Bottom Justify must be 
unchecked) the first title/names in each column will be aligned with 
the CONTROLS null, and the second line will appear on a 
consistent “floor” line. You can adjust the distance from the 
CONTROLS null to this floor line using the ‘y-scale’ value on the 
CONTROLS null. NOTE: This is typically only used when only 
two title/name pairs are in each column. If more than two pairs exist 
in the column, only the bottom pair will appear on the floor line, 
and the rest will be spaced as normal below the CONTROLS null. 

l. Column x Adjust: A point control with an x,y coordinate that will 
adjust the x,y position of the individual column specified by x. Can 
be used on the CONTROLS null, but more often it is copied to an 
individual card to make local adjustments on single cards when 
needed. 
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m. Center Vertically: When checked, the anchor point of each Card 
will be adjusted to make the Card appear vertically centered in your 
Credit Composition. NOTE: The position inside the actual card is 
unaffected, so be aware that lengthy cards may run off the edge of 
the card and appear clipped even when Center Vertically is 
checked. 

n. Fade InOut: The number of frames each card should be faded in or 
out. When set to 0, cards simply cut from one to the next. Ignore 
FadeIn and Ignore FadeOut checkboxes on individual cards will 
override this value when checked and create a cut at the start or end 
of the card accordingly. 

o. Drop Shadow: The standard After Effects Drop Shadow effect. 
Each card in the Credit Composition has a matching effect that is 
parented back to this single control. Thus, a unified drop shadow 
Color, Opacity, Direction, Distance, and Softness can be set here 
that will apply across all cards in your Credit Composition. 

 
 

In addition to the Effect Controls on the CONTROLS null, the null 
position and scale also effect the layout of your credits. The position of the 
CONTROLS null will define where your credits first column is located. 
(Stacking above or below the null depending on your selection of the 
Bottom Justify control)  The x-scale of the CONTROLS null will set the 
width between columns in your layout. The y-scale, when “Bottom Line 
Floor” is checked, will set the distance between the upper line and bottom 
line. 

CONTROLS nulls maybe be duplicated and placed down the layer 
stack in your timeline to create different sections within your credits that 
have a different design. (i.e. You may want larger centered cards for the 
first few, then set a second CONTROLS null to begin a two or three 
column section of smaller names that appear at the bottom of the screen.) 
Note the first CONTROLS null must not be renamed. All subsequent 
CONTROLS nulls may have additional text added to describe them, but 
must have a name that begins with CONTROLS to work properly. 

 
VI. Card Layers 

 
Inside each Card layer in your Credit Composition you will find one of 

three types of layers: Column headers, Title layers, and Name Layers.  
 
1. Column Headers: Column headers are null objects that signify the 

start of each new column. “Column 1” should always be the top layer, 
which subsequent headers (“Column x”) should be placed above the 
first title in the new column. 
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2. Title Layers:  Title layers contain the job title/position for each credit. 
They should always be paired with a name layer below them, although 
they may be left empty if you don’t want it to be visible. 

3. Name Layers:  Name layers contain the name/names of people 
associated with the title above them. They should always be paired 
with a title layer above them, although they may be left blank if you 
don’t want names below them. 

 
Because the position and appearance of all of the titles and names are 

controlled via expressions linked to the CONTROLS null, attempting to move 
them will have no effect. 

All titles and names may be edited. Or, if new title/name pairs need to be 
added, simply duplicate an existing pair and move them into the position you need 
the new pair added. If title/name pairs need to be re-ordered or moved to a new 
column, simply select them and move them into the appropriate layer position in 
the timeline. In all these cases, because the positions of the title/name layers are 
set by expression, they will automatically move into place. 

 
 

 
VII. Tools 

 
At the bottom of the Script UI panel is a selection of tools used to help 

update or make changes to your Credit Composition. They are: 
 

1. Retime Comp: Updates the timing of the cards in the currently active or 
selected Credit Composition. If the checkbox on the Format Tab is 
checked, the values for Duration and framerate will be set to the values 
entered on the Format Tab. Then, the duration of the Card layers of the 
composition will be recalculated from the Fixed and Weighted Duration 
values on each layer, and the in/out points of the layers set accordingly. 

2. Resize Comp:  Resizes the active or selected Credit Composition to the 
value selected in the Format Tab. Some CONTROLS Null values will be 
adjusted to match the look of the existing credits at the new size. 
However, due to the nature of the calculations, some variation may occur 
and you will need to re-adjust your CONTROLS null settings. 

3. Rename Comp: A dialog will ask for a new name for the Credit 
Composition. The Composition and parent folder will be renamed, and all 
of the expressions in the Card layers updated accordingly. 

4. Copy Comp: A dialog will ask for a name for the new Credit 
Composition. The Composition and parent folder will be created, and 
copies of all the Cards will be created and their expressions updated 
accordingly. 

5. Copy Fonts: Copies the font settings (and applicable CONTROLS Null 
values) to the clipboard from the currently selected card layers and/or 
CONTROLS nulls in the Credit Composition.  
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6. Paste Fonts: Pastes from font settings copied previously to the active or 
selected card & controls layers in the Credit Composition. 

7. Save Card: Prompts the user for a name to save the currently selected 
card (in a Credit Composition). The card’s settings will be ‘baked’ in and 
it will be saved into the “_SAVED CARDS” folder. This is useful for 
saving cards that have logos, images, or other modifications that will be 
used again in similar Credit Compositions. Because the values will be 
baked in, they will no longer update styles or positions in future Credit 
Compositions. 

8. Export .txt: Launches a Save File dialogue in order for you to save the 
current Credit Compositions credits back to a .txt file. This is useful if 
changes have been made since the credits were created, and need to be 
sent back to the Client. Because this is only a tab delimited text file, it will 
open back into Excel just as it was before, but will not retain any 
formatting. (colored cells, etc.) 

9. Insert Card: Creates and inserts a new Card after the selected card in the 
Credit Composition. It will duplicate the information in the originally 
selected card. All the card layers later in the timeline will be renumbered 
accordingly. The Credit Composition will be re-timed and the new card 
loaded into the viewer and timeline windows automatically. 

10. Remove Card: Deletes the selected card from the Credit Composition and 
re-times the remaining cards. The source composition of the card will also 
be deleted from the “Cards” folder and the subsequent cards re-numbered 
accordingly. 

 
 
 
VII.  Using the Google Doc Template 
  

 From the Help Tab you can select to download our Google Document 
Templates. At the link, you will find 4 pre-made templates with different numbers 
of columns. You can copy and work from these directly from your Google Docs 
account for easy team sharing, or download as an Excel file for offline work. The 
template should be given to whoever is compiling your credits. It contains a few 
sample cards already filled in to help you.  
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a. Show Information:  In the third Column, enter the name and episode number of 
the credit file. This information will be used by SLCH to name your credit 
compositions. After Duration, enter the total duration (in seconds) of the credits 
you want to create. 

b. Card Sample: Replace the sample card information with your credits. You many 
insert rows as need for additional titles and names within each Card. Be sure to 
always type Titles into the appropriate column, and Names into the next column. 
Additional Cards may be added by copying all the cells of any card and inserting 
them back into the sheet where needed. 

c. Timing Columns: If the card has a required on screen duration (in seconds), type 
this value into the “Fixed Dur” column at the top of the appropriate card. Fixed 
Duration values (besides zero) will always override the Weighted Duration value.  

If the card does not have a required duration, but you would like its 
duration to be twice as long, three times as long, etc. of the other cards, type this 
value in the “Weighted Dur” column. 

(Note: If both values are left blank, the card will be made with the default 
Weighted Duration of 1. Thus, all the cards will be the same length in the final 
composition.) 

 
     Once you have finished filling out the credit document, you should save it 
as an Excel .xlsx workbook for future editing. However, for use with SLCH, you 
must save a copy of the workbook as a standard tab delimited text file with the 
.txt extension. Google Doc or Excel files are not able to be directly used by 
SLCH. 

 
  

Figure 2. SLCH Google Doc Credit Template 

A.	Show	
Information	

C.	Timing	
Columns	

B.	Card	Sample	
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IX.  Additional Notes 
  

1. Although the Script UI Panel is needed to create Credit Compositions in your 
After Effects project, the compositions themselves do not require the Panel 
once created. Thus, the After Effects project can be given out to others or 
archived and will load and render properly on any copy of After Effects 
assuming they have the correct fonts installed. 

2. In addition, since all position information is procedural on the layers, 
additional lines/names may still be added or moved between columns without 
the need for the Script UI panel.  

3. When Re-Timing a Credit Composition, only layers that have a source or 
name that begins with “Card” will be calculated. Therefore, backgrounds, 
alpha mattes, or other elements may be placed in the Credit Composition and 
will not be affected by retiming, or cause the cards to be Re-Timed 
incorrectly. 

4. Santa’s Little Credit Helper does a little work under the hood using some 
expressions as labels. Modifying any of these expressions may create errors or 
unforeseen effects. (i.e. Anchor Points, Rotation, etc.) 

5. Certain special characters may cause text files to load in incorrectly. (i.e. 
quotation marks) Please be sure to check your credits once loaded for any 
anomalies and make adjustments. 

6. It’s recommended that you enter all your titles & names in the spreadsheet as 
standard title case. (Upper Case First Letters Only) Using the all caps setting 
in the character palette can be used once inside after effects to force an all 
uppercase look to names or titles, while preserving the flexibility of trying 
different looks.  

7. If you use all caps in the spreadsheet, the values will be locked in once loaded 
and difficult to do. However, if you have an established look and know that 
you want things all uppercase, you are able to enter them all caps in the excel 
spreadsheet and they will load that way. 

8. All Caps, Small Caps, and other character settings can be read but not written 
by scripting. Therefore, these settings will not be preserved when 
saving/loading Presets. However, they can be copy/pasted from one card to 
another using the Copy Fonts/Paste Fonts tools. 

9. When using the Copy Fonts tool, the look of only the first title and first name 
layer in the selected Card will be copied. Thus, if you are making a change 
you want to copy and paste to other cards, you need only change the first two 
layers inside your card, and paste it to whatever cards you wish to update. 

10. While many CONTROLS null sliders are independent adjustments, Scale and 
Spacing adjustments may seem to effect the appearance of other aspects of 
your credits. (i.e. Name Spacing will affect the spacing distance above the 
first name, thus seeming to change the Title-Name Separation.)  However, 
they are placed in an order on the CONTROLS null to make a top-down 
approach the most effective when making your initial adjustments.  
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11. Although they may be re-ordered, all effect controls on the CONTROLS null 
must not be re-named or removed from the CONTROLS null.  

12. Except Drop Shadow controls, all other CONTROLS null controls may be 
copied to an individual card layer to make single card adjustments. 
Checkboxes on an individual card will override the CONTROLS null value, 
while slider values will add to the CONTROLS null value. (Negative values 
will subtract.) 

13. If you want to leave a blank line in a name or title layer for spacing reasons, 
you may add as many extra carriage returns as you like. However, because the 
block spacing and other spacing expressions ignore empty lines, you must also 
add at least one space character (“ “) on each line you wish to add. 

14. When loading credits or creating empty credits, they will automatically use a 
basic default style. If you would like to override this style with something 
else, simply save the desired style as a Preset named “default”. This will now 
be loaded automatically anytime new credits are loaded or created. If you 
wish to change the default again, simply overwrite the “default” Preset with a 
new one, or delete it from your Credit Presets folder to go back to the standard 
default style. 

15. Compatibility Notes, After Effects Version 13 & 14:  For Santa’s Little Credit 
Helper’s expression to position and alight things properly, the character 
leading on all of the text layers inside your cards must be set to 0.  However, 
in prior versions of After Effects, it is not possible to do this through scripting.  
When you Load or Create a new version of credits using one of these 
versions, a pop up window will alert you and ask you to set one card 
manually.  Once you press continue on the alert window, it will automatically 
copy this setting through the rest of your credits.  Once that’s done (only once 
for each Credit Composition you create) the rest of the features of SLCH 
should operate normally. 

16. TRIAL MODE:  If you have not purchased a license for Santa’s Little Credit 
Helper, you will have the option of trying it out in Trial Mode.  You will be 
limited to only Loading or Creating Credit Compositions with a total of 10 
Cards.  You also will not be able to use the export .txt function.  
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IX.  Appendix - Credit Styles Visual Guide 
 
 

• Standard Layout 
 

When no other checkboxes (Bottom Justified, Bottom Line Floor, 
or Side x Side) are checked, the standard layout of credits sets the 
upper left title of the first column at the CONTROLS Null. Names and 
columns continue down and to the right, based on the other size, scale, 
and spacing values. The X-Scale value of the “CONTROLS null sets 
the spacing between columns. 

 
 
 

 
 

•  
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• Bottom Justified 
 

When Bottom Justified is checked, the bottom name in the first 
column is placed at the position of the CONTROLS null. Names and 
columns continue up and to the right, based on the other size, scale, 
and spacing values. The X-Scale value of the “CONTROLS null sets 
the spacing between columns. 
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• Bottom Line Floor 
 

When Bottom Line Floor is checked, the first title in each column 
is aligned to the Y-position of the CONTROLS Null with the 
coinciding names listed below. The X-Scale value of the 
“CONTROLS null sets the spacing between columns. In each column, 
the last title/name pair is aligned to the “floor.” This floor line is 
determined by the Y-Scale value of the CONTROLS Null. The X-
Scale value of the “CONTROLS null sets the spacing between 
columns.  

When columns have only one title/name, they will sit on the top 
line. To move them to the bottom line, simply add a pair of blank 
title/name text layers above them inside the Card source composition. 

This format is designed for credits typically only have 2 title/name 
pairs in each column. If your credits have more than 2 title/name pairs 
in a single column, only the last pair will sit on the “floor” line, and 
the rest will align below the above credits using the usual ‘block 
spacing’ control values. 

NOTE: The Bottom Justified checkbox will override the Bottom 
Line Floor checkbox. Please check this setting if you are not seeing the 
desired results. 
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• Side x Side 
 

When Side x Side is checked, Titles will appear to the left of the 
appropriate names. All of the title/name pairs will appear in one 
column, starting from the top and reading down. The lowest most 
name will be aligned with the position of the CONTROLS null. The 
title-name separation slider will now control the horizontal width 
between the titles and names. 

 
 
 
 
 
1 
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